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Setting Up

Loading the plugin in Maya

After installing the T-Splines plugin, you need to tell Maya to use it. 

• On the menu, select Window -> Settings/Preferences -> Plug-in Manager. 
• Look for "TSplineShape" (it will be followed by .mll, .so, or .lib; this depends on your 

operating system). You may need to scroll down to find it. 
• Put a check in both the "loaded" and "auto load" boxes. This will load the plug-in and make 

sure it reloads every time you start Maya. 

After you load the plug-in, a "TSplines" menu should appear on the menu bar. Most of what you 
can do with the plug-in is accessed through this menu. The menu contains links to the T-Spline help 
pages, the forum, and to many of the operations that you can perform on T-Splines. 

Creating a Shelf

To create a shelf with commonly used functions, choose "Create Shelf" from the T-Splines menu. If 
it's your first time creating the shelf, a new "TSplines" shelf will be added and will be filled with 
icons. If the shelf already exists, it will re-add any icons that may be missing. Even if you add your 
own icons to the shelf, you can safely "Create Shelf" again; it will not modify your existing icons. 
It's a good idea to use "Create Shelf" after upgrading to a new version of the plug-in, as we will 
probably add new icons on occasion. 

Adding menu items to the shelf

You can always add any menu item to the shelf. On Windows or Mac OS X, hold down Ctrl+Shift 
while clicking the menu item to add it to your current shelf. On Linux, hold down Alt+Shift to do 
the same thing. 
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The Location of the "Create Shelf" Menu Item

Creating Hot keys

Clicking "Create hotkeys" on the T-Splines menu will set up the keyboard to be usable with T-
Splines. You should only need to do this once. T-Splines hotkeys include 1, 2, & 3 (to change the 
preview quality), and the arrow keys (for pickwalk).
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Creating T-Spline Shapes
The T-Spline plugin imitates Maya's user interface as much as possible. If you are an experienced 
Maya user, the methods for creating T-Splines will be intuitive. 

Method 1: Creating T-Spline Shapes by Using the Shelf

There are several shapes that can be created from clicking on the icons on the T-Splines shelf. 
Available shapes include a sphere, cone, plane, torus, and cylinder. 

Create sphere icon Create cone icon Create plane icon Create torus icon Create cylinder icon
• These methods use the NURBS shape creator, and then immediately convert the created 

NURBS to a T-Spline shape.  

• To change options, use the option boxes on the Create > NURBS Primitives menu.
• When you change the default creation behavior for a NURBS shape, that same 

behavior will apply to the equivalent T-Spline shape. 
• You can get the same effect by creating a shape with history and then modifying the settings 

on your T-Spline shape's "makeNURBS" node. 

Method 2: Creating T-Spline Shapes by Converting from Other Shapes

You may take an existing shape made with NURBS, subdivision surfaces, or polygons, and convert 
it to a T-Spline. For many models, it is more convenient to rough out the model using the polygon 
tools, and then switch to a T-Spline to do the detail work. This is currently subject to the following 
behaviors.

Conversion behavior

• NURBS -- All NURBS convert exactly to an equivalent T-Splines. All T-Spline shapes 
convert exactly to a series of NURBS.

• Subdivision Surfaces -- Periodic subdivision surfaces that contain only quads will convert 
exactly. If your subdivision surface contains N-sided faces (i.e. triangles, pentagons, 
hexagons, etc.), these will be split to quads before conversion, and the surface will not 
match exactly. If your surface is non-periodic, a single ring of faces may seem to 
"disappear", although their points still influence the surface (they will be in the hull, but will 
be missing from the surface). This behavior occurs because the T-Splines Plugin employs a 
true Catmull-Clark subd definition, while Maya has their own subd definition with special 
edging rules.
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• Polygons -- Polygon conversion is identical to converting the polygon to a subdivision 
surface control cage, and then converting the subdivision surface to a T-Spline. Thus, your 
polygon must convertible to a subdivision surface, and all of the subdivision surface 
limitations apply. 

Conversion modes

There are five modes for converting shapes to T-Splines, as detailed below. You can select your 
mode in the TSplines>Convert To T-Spline>Options menu.

• Conversion Proxy uses the original shape as a proxy for the T-Spline shape, which 
automatically enables history. This means that any changes to the original will be reflected 
on your T-Spline shape. Deleting history will delete the conversion proxy.. 

• Note: When animating, texturing, etc. do not use the conversion proxy. Instead, use the 
Polygon Proxy. 

Proxy Mode  
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• Copy leaves you with two shapes -- the original, and the converted T-Spline shape -- but 
makes them independent in the history. This is faster than proxy mode, but changes to the 
original shape won't affect the copy. 

Copy Mode

• Replace converts your shape to a T-Spline, and then deletes the original shape, so you are 
left with only the T-Spline. 

Replace Mode  
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• Create face sets when converting from NURBS remembers the layout of your NURBS 
patches. After merging, inserting detail, or performing other operations in T-Splines, the 
plugin will output the same layout of patches when converting back to NURBS. 

• Identify T-Junctions when converting from polygons will convert “T” vertices in a 
polygon to T-Junctions upon conversion. T-Junctions ensure C2 continuity and can be 
extended and deleted. Otherwise, these vertices would be converted to extraordinary points.

The example below shows the effect of detecting T-junctions.

Polygon cube (left) converted to T-Spline cube (right).

The T-junctions on the right side of the cube are detected properly, and show up as straight 
isoparms. The T-junctions on the left side of the cube could not be detected, because they 
are too close to the corner of the cube, which is an extraordinary point.

To make your T-junctions more detectable:

- Don't put them near extraordinary points
- Make sure that the surface has clean isoparm (edge) flow. Spiral shaped flows usually 
cause problems.
- Try to avoid n-sided faces other than those used for T-junctions. N-sided faces make the 
isoparm flow worse.
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Editing Tools

The Standard Maya Manipulators

The standard Maya manipulators will work on T-Splines. You can rotate, scale, or translate them, 

and you can manipulate faces, edges, and points separately. T-Splines does have a unique way of 

implementing some tasks: if you want to do texturing or UV mapping, please read the linked 

sections. 

T-Spline tools

The following tools were specially designed for use on T-Splines:

• Inserting points -- Adding more local control in an area 

• Extruding faces -- Creating more complex shapes 

• Deleting faces -- Cutting holes in the shape 

• Deleting edges -- Simplifying geometry 

• Merging -- Combining multiple surfaces into a single one 

• Splitting -- Slicing a surface into chunks 

• Creasing -- Creating sharp creases in your model 
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Inserting Control Points

Inserting Control Points
The ability to insert control  
points anywhere on the 
surface is the foundation of 
the T-Spline technology.

• Insertion overview
 
o When is insertion useful?
o Why is point insertion in T-
Splines better than in NURBS or 
subdivision surfaces?

• How to insert a point in T-
Splines

o Simple Point Insertion
o Inserting with the preserve 
surface option 
o Inserting with the preserve hull 
option 
o Inserting using options
o Inserting by using the 
Extend T-Junctions tool 

• Inserting Points tutorial: 
o Modeling a Face in T-Splines 

When is point insertion useful? 

Insertion is used to add detail to a model. Adding detail in T-Splines is 
easier than in both NURBS and subds since you can add single control 
points anywhere on the surface without changing the surface. T-Splines 
eliminates the need to extend your isoparms all across the model, as in 
NURBS, or to deal with a deformed surface, as in subds. Simply add a 
point where you need it and continue on with your modeling.

Why is point insertion in T-Splines better than in NURBS?

When inserting points in NURBS, you must extend the isoparm all 
across the surface. This can lead to unnecessary control points that 
weigh down your model. These extra points also make future 
modifications more difficult. The images below contrast inserting detail 
in a NURBS sphere and a T-Splines sphere.

Original Sphere
Many NURBS isoparms must be 
extended across the whole surface to get 
detail at the front of the sphere

T-Splines gives you that same detail in 
your desired area with much fewer 
control points.
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Why is point insertion in T-Splines better than in subdivision surfaces? 

Even if you insert a whole row of control points in subds it will change the surface. The only way to 
insert control points in a subd without changing the surface is to quadruple the number of control 
points--to split each face into four faces on the whole surface. On the other hand, if you choose to 
add local control points to a subd, the surface will be deformed, and you end up with extraordinary 
points, which don't always shade as desired. 

When inserting points in T-Splines, you are allowed to insert points and have only the desired area 
affected.  Point insertion in T-Splines is similar to point insertion in subdivision surfaces, except that 
T-Splines allows you to insert points without changing the surface. 

Inserting points in T-Splines vs. subdivision surfaces. Notice the deformation on the subdivision surface that doesn't 
exist on the T-Spline. Courtesy Eric Allen.
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How to insert a point 

You can insert as many points at a time as you would like. There are a number of options for 
inserting points to help you optimize your work flow.

1. Select the edge(s) where you would like to insert a point. 
2. Select TSplines>Insert Point. 

       3. All the edges will have a point added which splits them in half. If points exist at the same 
           interval on the opposite sides of a face, then an edge will be added between them.

In the picture below, the two yellow horizontal lines were each split in half, and the yellow vertical line was added 
between the two new points.

 

Preserve surface option on
 
TSplines>Tool Options>Preserve Surface 

This preserve surface option allows you to insert control points without changing the surface in any 
way until you move the control point. This makes adding detail a reliable process, and insures that 
you won't waste time repairing your model after inserting control points. 

This isn't just some slick new user interface, but a new and profound insertion process based on our 
patent-pending T-junctions. In order for this "mathemagic" to happen, sometimes it's required to add 
a few points beyond the ones you requested. One of the two T-junctions on neighboring sides of the 
face will be extended, splitting the face into two with an edge. The reason why the split occurs is 
because the surface will not be preserved without it. Note that if you don’t want these extra 
insertions to occur, you can change the tool option to 'preserve hull'. 
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Inserting an edge between the two yellow edges. After the point insertion, the surface is the same. One additional 
edge was inserted to preserve the surface exactly.

Preserve hull option on 

TSplines>Tool Options>Preserve Hull 

The preserve hull option is useful because it guarantees that the only control points added will be 
those you specifically requested. When you're adding detail in an already-dense part of the mesh, 
this option will keep down the number of control points. This option is also useful for creating 
blocky shapes. It should be noted that the preserve hull option often pulls the surface toward the 
control mesh and may change the surface.

Inserting an edge between the two yellow lines. After the point insertion, only the requested edge was inserted, 
with no additional geometry.
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Options 

Inserting with options allows you to choose how far along the edge your point is inserted. By 
default, the point is inserted halfway along the edge (a knot interval of .5). By selecting a knot 
interval anywhere from 0 to 1, you can determine where along the edge your point is inserted.

Knot Interval .3 Knot Interval .5 (default) Knot Interval .9

Extend T-Junctions tool 

The Extend T-junction tool provides a convenient way to perform the common operation of adding 
a control point in line with an existing T-junction.

To use this tool 

1. Select the T-Junction vertices or edges you want to extend.
2. Press TSplines>Extend T-Junction. 

The Extend T-junctions tool inserts a point on each edge that lies opposite selected T-Junctions. 
This tool makes inserting with options easier. The advantage of inserting with options is that it 
allows you to add control points anywhere along an edge. However, it may be difficult to determine 
exactly how far along the edge the control points were if you wanted to extend the detail along it. 
Extending T-Junctions allows you to extend this detail. 

Before extending the T-Junction
(yellow vertex selected) After extending the T-Junction
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Extruding Faces

Extrusion
Extrusion is a  
classic example 
where T-Splines 
weds the worlds of  
subd and NURBS 
modeling.

• Extrusion overview
 
o When is extrusion 
useful? 
o Why is extrusion in T-
Splines better than in 
NURBS?

• How to extrude in T-
Splines

o Simple extrusion
o Extrusion rules
o Converting extruded 
surfaces to NURBS

• Extrusion tutorial
 
o Modeling a toad in T-
Splines 

When is extrusion useful? 

Extrusion allows you to extrude a column from a flat surface. It is useful 
whenever you want to create appendages: you can extrude fingers from a hand, 
tree branches from a tree trunk, or a handle from a jug. The legs and fingers of 
this toad were made from extrusion. See the tutorial for details. 

Extrusion is a popular polygon and subd tool. T-Spline extrusion brings the 
benefits of this versatile tool to spline modeling.

Why is extrusion in T-Splines better than in NURBS? 

Extrusion is not possible using Maya’s NURBS, although it is a commonly 
used polygon tool. To achieve a similar effect as extrusion using NURBS, you 
would need to create NURBS patches, which would not be connected to the 
surface. Extrusion allows you to expand the complexity of your model while 
keeping it as one seamless object. 
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How to extrude in T-Splines

Simple extrusion

1. Select the face(s) you would like to extrude.
2. Select TSplines > Extrude 
3. Select the Maya move tool to extrude in the direction you would like. 

Extrusion Rules
Kitty-corner 

If your group of faces has any face pairs where only a corner is shared ("kitty-corner"), you will get
an error.  

 
These faces could not be extruded together These faces could be extruded together

T-Junction corner

Extrusion is also disallowed if any of the faces have a corner which is a T-junction on a face that is 
not being extruded. 

Converting extruded surfaces to NURBS

T-Splines with extrusions don't convert exactly to NURBS since they contain extraordinary points.  
There will still be a close approximation to any level of tolerance, which can be specified by the 
user (by increasing the number of Adaptive Subdivisions in the Attribute Editor). However, 
extruding in T-Splines is still preferred to extruding in subds, since T-Splines requires fewer 
extraordinary points. After the initial extrusion, detail on the extruded T-Spline area can be added 
with T-Junctions (subds require extraordinary points), and using T-Junctions makes for a more exact 
conversion to NURBS.
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Deleting Faces

Deleting Faces
Deleting faces allows you 
to create detailed sections 
of your model separately,  
then merge them 
seamlessly together.

• Deleting faces overview
 
o When is deleting faces useful?
o What is the benefit over 
NURBS?

• How to delete faces in T-
Splines

o How to delete faces
o Changes in the mesh

When is deleting faces useful? 

Face deletion can be used to cut holes in a mesh or to cut away  its sides. 
This is useful if you want to shape one half of a model and then mirror 
your work. It is also useful when merging surfaces. For example, 
suppose you have a model of a head without ears and a separate model 
of an ear. You can delete faces on the side of the head to make a hole. 
Then the model of the ear can be merged with the head along the border 
of the hole to create a seamless connection between the ear and the head. 

Deleting faces is also useful when simplifying symmetric NURBS 
models converted to T-Splines. By deleting half the model, simplifying 
the remaining side, mirroring, and merging you can reduce your 
modeling time.

What is the benefit over NURBS? 

It is not possible to delete faces using Maya’s NURBS. Deleting faces 
allows for reduced geometry, and merging two objects after deleting 
faces generates gap-free intersections. 
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How to delete faces

1. Switch to face mode. 
2. Select the face(s) you want to delete. 
3. Select T-Splines>Delete Faces 

Deleting a Face in T-Splines 

Changes in the mesh

Some changes may occur in the mesh when faces are deleted. These changes might include moving 
existing vertices, and inserting new vertices, edges or faces. There are two reasons for these changes: 

1. To preserve the shape of the surface around the deleted area. 
2. To make sure the new boundary is compatible with merging. (Merging can only occur when the 
two surfaces meet certain conditions along their borders. See Merging.) 
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Deleting Edges

Deleting Edges
Deleting edges allows 
you to smooth your 
model and reduce 
your geometry.

• Deleting edges overview
 
o When is deleting edges 
useful?
o What is the benefit over 
NURBS?

• How to delete edges in 
T-Splines

o How to delete edges
o Rules for deleting edges
o Simplifying large areas 
at once

Deleting Edges 

When is deleting edges useful? 

Deleting edges is one of the main ways to simplify the geometry of your 
model, especially after converting from NURBS. Since control points don’t 
need to continue all around your model in T-Splines, but are allowed to 
terminate in T-Junctions, by deleting edges you can remove unneeded 
geometry in smooth areas of your model. This leads to a lighter model that is 
easier to manipulate. 

In the figure above, 75% of the control points were removed by deleting 
edges. This resulted in a smoother model (especially notice the forehead and 
neck) that is much lighter. 

What is the benefit over NURBS? 

Removing detail locally by deleting edges is impossible to do using Maya’s 
NURBS unless you delete an entire row of points. Deleting edges allows for 
smoother surfaces and easier manipulation. 

How to delete edges 

1. Use the right click menu to view the "Deletable Edges" component. The deletable edges will be 
bolded.
2. Select the edge pairs that you wish to delete. 
3. Choose "Delete Edges" from either the shelf or the menu, or hit the delete key. The selected edges 
will be deleted. Edges are deleted in pairs because each deleted pair of edges removes one control 
point.
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Deleting Edges: The two horizontal edges under the yellow edges will be deleted 

After Edge Deletion: The Simplified Torus 
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Rules for deleting

To keep the T-mesh consistent, edges must be deleted in pairs. This is because each edge pair 
deletion gets rid of one control point. 

Also, there are two instances when edges are not deletable. First, if an edge touches an 
extraordinary point, it is never deletable. Second, if your deletion would result in an n-sided face or 
an L-junction, it is not allowed. You would first need to delete surrounding edges to make the 
deletion permissible.

You must be in deletable edge mode to delete edges: you can't delete edges if you are merely in 
edge mode.

Simplifying large areas at once

The Fill Deletable Edge Region tool allows you to easily simply large areas of your model. This tool 
allows you to select a number of deletable edges within a rectangular area. The area to be filled is 
indicated by selecting a vertex at opposing corners of the rectangle. If the area indicated by the 
verticies is ambiguous, you can clarify the selection by selecting a face inside the area and touching 
one of the verticies.  The options box allows you to determine how many deletable edges are 
selected in the U and V directions.

Extraordinary points cannot be included on the edges or inside of the area to be simplified when 
using this tool.

Fill Deletable Edge Region

Before Deletion                                                                             After Deletion
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Merging

Merging
Merging NURBS 
patches into a 
seamless T-Spline 
model greatly aids the 
animation process.

• When is merging 
useful?
 
o When is merging useful?
o Merging existing 
NURBS models
   o Tutorial
o Merging T-Spline 
generated objects
   o Tutorial

• Preparing for the 
merge

o Preparing for the merge 

• Performing the merge

o Performing the merge
    1. Simple merge
    2. Merging around a 
whole surface 
    3. Merging gaps
    4. Merging around 
corners
    5. Merging inside 
corners

• After the merge 

o Crease removal
o Reducing geometry 
(deleting edges) 

18-patch NURBS face Seamless T-Spline face
Source: Balloon girl character from the animated short Bingo, Chris Landreth

When is merging useful? 

Often in modeling it is convenient to build or design models in a piece-wise 
fashion. Merging allows you to join these individual pieces into a single gap-
free model to facilitate animation and future modification. Merging is one of 
the powerful T-Spline tools that invites reconsideration of your work flow, 
since things that were difficult to do in NURBS or subd work flows are
 natural and straightforward in T-Splines. There are two cases where merging 
is useful in T-Splines: merging existing NURBS models, and merging as part 
of a T-Splines work flow. 

Case 1: Merging existing NURBS models 

Merging multi-patch NURBS models into seamless T-Spline models offers 
many advantages. Creating and simplifying seamless models allows you to 
more easily repurpose your existing NURBS models, and seamless models 
are easier to animate and are preferred in analysis. 

• Tutorial: How to merge NURBS patch models in T-Splines 
                 http://www.tsplines.com/resources/merging.html

22

http://www.tsplines.com/resources/merging.html
http://www.tsplines.com/resources/merging.html
http://www.tsplines.com/resources/toad.html
http://www.tsplines.com/resources/merging.html


Case 2: Using merging in your T-Splines work flow

Merging can also be used to assemble models designed from scratch in T-Splines. One popular 
application of merging is to mirror one side of a symmetrical object and merge the two halves 
together.

• Tutorial: Using extrusion and merging to create a T-Spline 
                  http://www.tsplines.com/resources/toad.html

Preparing for the merge 

Prepare for the merge by completing the following steps: 

1. Convert all your geometry to T-Splines. 

2. Select the objects you wish to merge, and turn on the border vertices display (TSplines > Display 
Options > Border Vertices) to make it easier to spot the vertices that you'll need to select. 

3. Line up the objects in roughly the positions you want them to be in after the merge.

4. Select the two objects in either vertex, hull, or edge mode. You can merge objects by joining either 
their vertices, hulls, or edges. If the hulls of your two objects align, merging the hulls is faster than 
selecting and merging the individual vertices or edges. The instructions below detail merging in 
vertex mode, but similar instructions apply for edge and hull modes. Watch the video clips at 
http://www.tsplines.com/doc/index.html for more documentation about the different kinds of merges.

Performing the merge
The merging capability of T-Splines allows you to merge any two objects that were designed with 
the intention of being pieces of the same continuous model. We've provided some basic merges 
below as illustrations of how to use this tool.

Technically, any two open objects may be merged together; however, if they were 
sloppily parameterized they may not merge correctly. 

23

http://www.tsplines.com/doc/index.html
http://www.tsplines.com/resources/toad.html
http://www.tsplines.com/resources/toad.html
http://www.tsplines.com/resources/toad.html
http://www.tsplines.com/resources/toad.html


Case 1: Simple Merge

The simplest case is merging two straight edges together. Select the corner vertices at each side of 
the edge before merging. If you have border vertices turned on, then the corners will be marked 
with light-gray frames. You don't have to merge all the way from corner to corner; if you wish, you 
may merge only part of the edge

Simple Merge 

Case 2: Merging around a whole surface

This technique is used to merge two looped edges together. If you wished to turn a cylinder into a 
donut by connecting the two ends, then you would use merge this way. Ditto when merging an arm 
to a hand, as shown below. This technique only requires you to select two vertices, one on either 
side of the merge. These two vertices will become a single vertex in the merged shape, and the 
other vertices will line up relative to them.

Merging around a whole surface 

Here, we will merge the hand to the arm.
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Select two verticies across from one another, one on the hand and one on the arm.

Select Tsplines > Merge. The hand and the arm will be merged all the way around. 
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Case 3: Merging Gaps

By merging gaps, you can close a slit in the middle of a surface. To close a gap, select the two 
corners at either end of the slit, and hit merge.

Gap Merge 
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Case 4: Merging around corners

If you need to merge around a corner, then you must do the merging in several steps. The first step 
is to choose two straight edges and merge them together as you would with a simple merge. Next, 
continue sewing along the edges with subsequent merges -- these additional merges will require you 
to select groups of three vertices. The following images show how to do this. 

Merging around Corners: Initial Merge 

Merging around Corners: Using Groups of Three Vertices to Sew 
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Merging around Corners: Final Sewing Step 

Merging around Corners: Result 
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Case 5: Merging inside corners

You can merge inside a corner by selecting a point inside the corner and one border point along 
each of the borders that extend from the corner.

Merging inside Corners: Selecting Verticies 

Merging inside Corners: After the Merge 
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After the Merge

Removing creases

After you merge two surfaces together, it is usually desirable to remove any existing creases to 
obtain a smooth surface. One option is to use automatic crease removal, which will automatically 
remove any creases that may appear after merging. However, if you only want part of your merge 
to be smooth, you may choose to remove creases manually.
Merged surfaces (before crease removal) Merged surfaces (after crease removal)

Manual Crease Removal
Removing creases from the surface causes the surface to change. If you have many creases to 
remove, you will get better, more symmetric results if you remove all the creases at the same time, 
instead of deleting each crease separately. This is particularly true if you are deleting creases that 
intersect with extraordinary points.

There are many ways to delete a crease. Possibly the simplest is to select all of the edges along the 
crease's main isoparm (this is usually easy to do in 'hull' mode) and then choose "Remove Crease." 
You can select many creases at once this way and remove them all, if you wish.

Removing creases is most commonly desired when you have been merging surfaces together, as 
when converting a NURBS patch model to a T-Spline. You can use the remove crease command to 
remove these, but to speed up the workflow we have provided an easier way.

30



Automatic Crease Removal
To automatically remove creases, check the "Make Edge Sets" box before you start merging (under 
the Merge Option Box). That way, all of the creases will be recorded while you are merging. Then, 
after you have finished merging the model together, choose "Remove Merge Creases" from the T-
Spline menu. This will go through the list of all recorded merge creases and remove them. This is 
the same as selecting all of the merge creases and using the "Remove Crease" command, except that 
you don't need to go to the trouble of selecting them all.

If you wish to see which creases are to be removed, select your T-Spline, turn on the "Edge Sets" 
flag under TSplines -> Display Options, and then switch to Hull or Edge viewing mode. The crease 
edges will be shown in various colors, with a different color for each of the creases. You can use 
the TSpline -> Sets menu to edit these, if you wish. These are the commands:

Create Edge Set - Select edges which you wish to make into a set and then choose this option. If 
any of the edges were already in a set, they will be switched to your new set. If you accidentally 
merged several surfaces with the option off, but still want to do automatic crease removal, you can 
use this command to add the creases to the list of creases to be removed.

Select Edge Set - Select any edge that belongs to a set, and then use this command to select the 
remainder of the edges in the set.

Clear Edge Set - All sets associated with the selected edges will be deleted. If you just select the T-
Spline shape, then all edge sets will be deleted. This is useful if you wish to retain certain creases, 
or just for cleaning up after crease removal. 

Reducing Geometry

Once your object has been merged, it is common to reduce the geometry to make the object lighter 
by deleting edges. See Deleting Edges. 
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Splitting
Splitting allows you to break sections off  
your model and work on them 
independently.

• Splitting overview
 
o What is splitting?
o When is splitting useful?

• How to split faces in T-Splines

o How to split faces

What is splitting? 

Splitting can be thought of as the inverse (or opposite) 
of merging. In merging, two surfaces are combined into 
one. In splitting, one surface is divided into two. 

The operations of splitting and deleting faces are also 
very similar. The only difference is that with splitting, 
the selected faces are made into a new, separate surface. 
With deleting, the selected faces are removed and 
thrown out. 

Splitting will create boundaries on the resulting 
surfaces that are mergible with other surfaces. 

When is splitting useful? 

Splitting can be used for various artistic effects, 
whenever you want to separate two parts of a model.

To split a face 
1. Select a group of faces 
2. Select TSplines > Split Surface.  The selected faces will be made into a new, separate surface, 
which may be manipulated independently of the original. If you have history turned on, the two 
shapes will share their history, so any changes will still affect both shapes. 

Splitting a T-Splines Surface 

After splitting, you must still have two entirely contiguous T-Spline shapes; you can't use it to cut 
off many different parts of the surface at once. If you need to cut the surface into many pieces, you 
should cut the pieces out one at a time. 
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Creasing

The ability to add sharp, local creases is  
unique to T-Splines.

• Creasing overview
 
o When is creasing useful? 

• How to insert a crease in T-Splines

o How to crease
o Creasing with options
o Creasing with history

• Creasing tutorial: 
o Modeling an Iguana in T-Splines 

When is creasing useful? 

Creasing allows you to get sharp edges in your model. 
The lines in the girl's head above and the ridges in 
the old man's forehead below were created by creases. 

How to crease 

1. Select the edge(s) you would like to crease.
2. Select TSplines > Crease.
3. Using the Maya move tool, extend the crease out as far as you would like.

Creasing with options
Options allow you to change the sharpness of the crease from -10 to 10. Values between 0 and 10 
make the peak of the crease progressively sharper, while values between 0 and -10 make the base of 
the crease progressively sharper.

Sharpness 3 Sharpness 9
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Sharpness -3 Sharpness -9
 

Creasing with history
History allows you to edit the sharpness of your crease in real time. With history on, you can change 
the sharpness and see the changes reflected immediately by using the slider in the tsCreaseNode.
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Conversion to NURBS
To convert from T-Splines to NURBS, simply select your T-Spline object and select the Convert to 
NURBS tool. When you convert to NURBS, the T-Spline plug-in will automatically select 
boundaries for the NURBS patches. These boundaries are fairly arbitrary -- any way of dividing up 
the model into rectangular regions will work, and sometimes you might prefer a particular way of 
dividing things up. Controlled NURBS conversion allows you to provide guidance to the NURBS 
conversion algorithm and output the patches that you want.

Controlled NURBS conversion uses face sets. You mark rectangular regions of the model as all 
belonging to the same set; these regions will always show up as a single NURBS patch in the final 
conversion. You are welcome to leave parts of the model unmarked -- these will be converted using
the automatic division.

To build face sets, you can use the options on the "Sets" menu:

Create Face Set - Select a rectangular group of faces and choose this option to make a new face set. 
Faces that were already in a set will be moved to your new set.

Select Face Set - Select any face and choose this option and all faces in that set will be selected.

Clear Face Set - Select any face and choose this option to return all faces in its set to being in no set. 
If you select the whole T-Spline in object mode, then this option will remove all face sets on the 
model.

When you convert to T-Splines from NURBS, there is an option to create face sets during conversion. 
A different face set will be created for each original NURBS patch. These sets are preserved through 
merging, so you can get back your original NURBS patches if you convert back to NURBS after 
modifying the T-Spline.
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Rendering
T-Spline objects are directly renderable with Maya software and hardware renderers and mental ray. 
Rendering is disabled in the Learning Edition.

Rendering Options
The quality of the render can be controlled by the T-Spline Output Tessellation submenu in the 
Attribute Editor. 

Attribute Editor

The Divisions box indicates the number of times each face edge will be subdivided in the render. A 
higher number will result in a smoother, more accurate render.

The Tolerance box is activated only when Curvature Check is on. By setting the tolerance between 
.01 and 10, you can set the curvature accuracy to a desired tolerance. This yields an optimized render 
with fewer polygons but also takes longer to render than just increasing the number of divisions.

Note: When rendering large scenes, it is recommended to shorten your undo queue (Window-
>Settings/Preferences->Preferences->Undo) to 5-10 commands to improve performance and reduce 
the risk of not running out of memory, since T-Spline render commands are stored in the undo queue. 
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Concepts
This section describes important concepts that are unique to T-Splines.

The Polygon Proxy

Display Options

Selection 

The Polygon Proxy
The polygon proxy for your T-Mesh allows you to access Maya's tools for skinning, texturing, 
animating, boning, etc. All operations performed on the proxy will also be performed on the T-
Mesh. To create or refresh the polygon proxy, choose "Create Polygon Proxy" from the T-Splines 
menu. 

The main purpose of the polygon proxy is to allow you to animate and texture map your T-Mesh. 
Simply use the Maya tools as you normally would to animate or texture the polygon, and the same 
operations will be performed on the T-Spline. The only limitation is that you shouldn't add or 
remove edges, points, or faces from the polygon. Additionally, if you change your T-Spline while a 
proxy is active, you should delete and recreate the proxy before continuing. You can always delete 
the proxy at anytime without losing any information -- the actual values are stored directly on the 
T-Spline. 

By default, dragging points on the proxy will update the T-mesh, and changing UV's on the proxy 
will change the T-Mesh's UV's. You can turn off either of these options through the "Create 
Polygon Proxy" option box.

Creating a Polygon Proxy in T-Splines 
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Display Options
Display options let you force different components of the T-Spline to remain visible, even when a 
particular shape or component type isn't selected. Some of the options also change the way you 
view the T-Spline to help with certain tasks. To change display flags, you must have the shape(s) 
selected in object mode, and then select the flag you want to toggle from the Display Options 
available on the T-Splines menu. Available options are listed below. 

• Vertices -- Control vertices remain visible, even when not in vertex-selection mode. 
• Hulls -- The edges (hull) remains visible, even when not in edge-selection mode. 
• Solid Hulls -- The curved surface and isoparms will not display; instead, the hull will be 

shaded as if it were the surface. This mode is often useful because it keeps vertices from 
being hidden beneath the surface, but still lets you see the basic 3D shape. 

• Tessellation Lines – Shows the polygon boundaries of the T-Spline tessellation.
• Face Points -- The center point of every face will always display. 
• T-Junctions -- When viewing vertices, T-junctions will be displayed in light blue. 
• Extraordinary Points -- When viewing vertices, extraordinary points will be displayed in 

pale red. 

• Border Vertices – Highlights vertices on the edge of a T-Spline to identify candidate 
vertices for merging. Only verticies on the edge (border) of the mesh can be used for 
merging. Corner verticies are outlined in white, and non-corner verticies are outlined in 
black. Merging around a corner in a single merge is invalid; perform this in parts by first 
merging up to the merge and then continuing the merge.

• Vertex-Surface Lines – Draws a line from each vertex to the surface showing the vertex's 
center of influence.

• Face Sets – Displays each existing face set in a different color. Face sets show which faces 
will be grouped together when converting from T-Splines to NURBS.

• Edge Sets – Displays each existing edge set in a different color. Edge sets are usually 
created when during merging and indicate possible creases.

• Heads Up Display – Displays the number of vertices currently selected.
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Selection
Normal Maya selection tools should work as expected; additionally, there are several commands in 
T-Splines that make complex selections easier to do. These are very similar to the ones found on the 
Edit Polygons -> Selection menu. They are listed below: 

• Grow Vertex Selection -- Vertices sharing a face with a selected vertex are added to the 
selection. 

• Shrink Vertex Selection -- Vertices sharing a face with an unselected vertex are deselected. 
• Select Border Vertices -- Only vertices sharing a face with an unselected vertex are 

selected. 
• Grow Face Selection -- All faces sharing a vertex with a selected face are added to the 

selection. 
• Shrink Face Selection -- All faces sharing a vertex with an unselected face are deselected. 
• Select Border Faces -- Only faces sharing a vertex with an unselected face are selected. 
• Convert Selection to Vertices -- Currently selected faces and edges are deselected, and 

their component vertices are selected. 
• Convert Selection to Edges -- Edges on a selected face or between selected vertices are 

selected. 
• Convert Selection to Faces -- Select faces whose vertices or edges are selected. 
• Span Deletable Edges -- Select any two deletable edges and then use this option to select 

all the deletable edges between them. This is useful for deleting long isoparms. 
• Extend Deletable Edges -- This extends all selected deletable edge pairs as far as possible 

along their isoparms. This is particularly useful for crease removal. 

• Fill Deletable Edge Region – Selects a number of deletable edges within a rectangular area. 
The area to be filled is indicated by choosing a vertex at opposing corners of the rectangle. If 
the area indicated by the verticies is ambiguous, you can clarify the selection by selecting a 
face inside the area and touching one of the verticies. This command is useful for thinning 
large areas of the model. The options box allows you to determine how many deletable 
edges are selected in the U and V directions.

Extraordinary points cannot be included on the edges or in the interior of the area to be 
simplified.

• Select T-Junctions Near Creases -- All T-Junctions that are adjacent to sharp creases (such 
as those created by merging) will be selected. This makes it easy to extend these T-
Junctions, which is necessary for crease removal. 
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Glossary
This glossary is to help clarify any new terms found in the documentation. 

Bezier End Conditions

The term "Bezier end conditions" refers to how the mesh behaves near its edges. This only applies 
to non-periodic meshes. If all the points at the edge of the mesh are attached to the surface, then you 
have Bezier end conditions. No matter how you move these points around, the surface will twist to 
keep touching them. If you don't have Bezier end conditions, then the points will still influence the 
surface, but the surface won't touch them. Bezier end conditions are created by having zero knot 
intervals at the edge of the surface. 

Contiguous

"Contiguous" means "completely touching," or "continuing without a break." For example, in the 
United States of America, we refer to the "contiguous 48 states" because these states are all 
touching.

Some of our operations require that you select contiguous groups of faces. Here are some examples:

These faces are contiguous, because all 
of them touch.

None of these faces are contiguous, 
because none of them touch.

These faces are not all contiguous; they 
are in two separate groups.

Control Vertex/CV

See: Vertex 

Deletable Edges

T-Splines allows you to simplify the mesh by deleting existing geometry. This will necessarily 
change your shape, although the plugin will try to minimize this for you. 

Deletion in T-Splines works by deleting pairs of edges that are across from each other, or by 
deleting T-junctions. There are rules which govern which edges are deletable, but they are quite 
complex, so as a visual aid, T-Splines has a "deletable edges" mode. This mode displays all the 
deletable edge pairs in the mesh. 
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Edge

Hulls are made up of vertices, edges, and faces. An edge is a line between two vertices. In the 
program, there is a distinction between normal edges and bordering edges -- those edges which 
occur at the edge of a mesh are drawn with a thicker line. If a mesh is periodic (such as a sphere), 
then there will be no border edges. 

There is a subtle distinction between edges and isoparms -- edges are elements of the hull, whereas 
isoparms are directly on the surface. Every point on an edge has a corresponding point on an 
isoparm on the surface. 

Extraordinary Point

An extraordinary point is a point with an unusual number of edges attached to it, where any number 
other than 4 is unusual. Note that T-junctions don't count -- a T-junction can have either 2 or 3 
edges attached, but are not considered extraordinary points for our purposes. 

Extraordinary points are very useful for modeling, but can cause some difficulties. The surface will 
not be perfectly smooth at extraordinary points, and T-junctions may behave differently near them. 
Additionally, a point cannot be both an extraordinary point and a T-junction at the same time. They 
shouldn't cause a problem for many types of modeling, but should be avoided for some 
applications. 

The most common ways to get extraordinary points are to merge T-Splines together, extrusion of 
faces, or converting from a polygonal mesh.

Extraordinary Point (center of the five edges)
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Face/Face Point

A face is a series of edges connected in a loop. They are part of the hull. The "face point" is a point 
drawn in the middle of a face. Faces are selected by clicking on their face points. Faces may be cut 
out of the surface to make holes, and they may be extruded to get the shape you want. 

Hull

The hull is the angular grid of faces, points, and edges which the modeler manipulates to control the 
curved surface. The hull is used primarily for modeling -- it is not displayed when the surface is 
rendered. "T-Mesh" is a synonym. 

Interval

See: Knot Interval 

Isoparm

Isoparm is short for isoparametric curve. In NURBS, an isoparm refers to a line on the surface that 
is parallel to either the U or V axis of the surface. These lines always stretch all the way across the 
NURBS surface. 

In T-Splines, surfaces do not have an even parameterization, so isoparms can be localized -- they 
may not stretch the entire length of the surface. The curved lines that you see snaking over the 
surface when viewing its wireframe are the "isoparms" of a T-Splines surface. 

Isoparms are very similar to edges, but there is a subtle difference -- edges are elements of the hull, 
whereas isoparms are directly on the surface. Every point on an edge has a corresponding point on 
an isoparm somewhere. 

Knot Interval

Knot intervals function in the same way as they do with NURBS, and differentiate T-Splines and 
NURBS from subdivision surfaces, which do not allow for knot intervals. The knot interval is a 
number that is attached to every edge in the surface, and affects how tightly the surface "hugs" that 
edge. The smaller the number, the more tightly the surface will hug the edge. If two adjacent edges 
have a knot interval of zero, then the surface will actually touch the point between them. 

Knot intervals are useful in providing local detail, because the surface will hug the hull more tightly 
in regions where a lot of refining has been done. Knot intervals are also very important for doing 
creases, as they allow you to sharpen the surface to a point. 

One of the rules for creating a valid T-Spline is that opposite sides of a face must have the same 
knot interval. If a side has multiple edges, then the sum of the edge's intervals is the side's interval. 
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Periodic

In T-Splines, we call meshes that have no borders periodic. A sphere is completely periodic, 
because the surface wraps around onto itself. A cylinder is periodic on one axis, but not on the 
other. A mesh which doesn't have this property, such as a plane, is called non-periodic. You may 
change the periodicity of a mesh by using merging or face deletion. 

Point

See: Vertex 

Quads/Quadrilaterals

In T-Splines, a quad is any face where the total number of vertices, minus the number of T-
junctions, is equal to four. Excluding T-junctions when counting points is unique to T-Splines; in 
particular, note the difference in definition between "side" and "edge." Currently, T-Meshes are 
always composed entirely of quads. 

Side

A side is all the edges along the side of a face between two corners. If all the vertices on a face are 
corners, then the sides and the edges will be the same thing; however, if there are any T-junctions 
on the face, then they do not count as corners, and a side may consist of multiple edges. 

T-Junctions

A T-junction is a point on the mesh that is not considered a corner in at least one of its surrounding 
faces. There are two basic types of T-junction: valence 2, and valence 3. A valence 2 T-junction is a 
point inserted along an edge, and has a face to either side. These provide a single additional point of 
control that mainly affects the two faces it touches. A valence 3 T-junction occurs when an edge 
terminates into the side of a face; this type of T-junction counts as a corner on the faces that the 
edge touches, but doesn't count as a corner on the face that it intersects. Note that it is possible to 
have a valence 3 extraordinary point as well, in which all three surrounding faces treat the point as a 
corner. They look similar, but the associated surface will be quite different. T-junctions tend to 
affect the surface in a more predictable, continuous way, and are preferred. Look at the section on 
"display options" for information on how to tell the difference.
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T-Junctions

 

T-Mesh

The T-mesh refers to the interconnected collection of faces, edges, and vertices that are used to 
control the shape of the surface. "Hull" is a synonym. 

Valence

Valence refers to how many neighbors something has. The valence of a vertex is the number of 
edges which are attached to that vertex. The valence of a face refers to the number of edges 
surrounding it (the number of edges and number of sides are not the same thing; in this version of 
T-Splines, all faces have four sides, but they may have several edges to a side due to T-junctions). 

Vertex

A vertex is a point in the hull. Every vertex has at least two edges coming off of it, and many have 
more. Every vertex is also part of at least one face. The shape of the T-Spline surface is based on 
the position of the vertices in the hull and their connections to one another. Most modeling is done 
by moving the vertices around, which changes the shape of the surface. 

In T-Splines, vertices are classified into three types -- normal vertices, T-junctions, and 
extraordinary points (see separate definitions). You can use the Display Options on the T-Splines 
menu to color code your vertices, if you wish -- extraordinary points are red, and T-junctions are 
blue. Vertices may also be referred to as Control Vertices, CVs, or Points. 
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